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Q. What are test objects? 
Test objects are objects created and maintained by QTP in its object repository. Each test objecthas a name and a set of 
properties to uniquely identify the actual object in the application. 
Q. how does QTP identifies the objects during the script run? 
During script run QuickTest searches for a run-time object that has the similar description of thetest object in the object 
repository. 
Q. How can i check the properties of an object in an application without using checkpoints? For Example how 
will you check whether a button is enabled? 
Answer: GetROProperty method is used to retrieve the properties of the object in an application.It is very useful method 
and can be used to retrieve almost any of the property that can be seenwhile spying the object with object spy. For 
Example‗To get whether button is enabled or not.  
Val = Browser("QA Friends").Page("QA Friends"). WebButton("Login"). GetROProperty("disabled") 
‗To get whether a checkbox is on or off. 
Val =Browser("QA Friends").Page("QA Friends").WebCheckBox("Test").GetROProperty("Value") 
Q. How can I modify the properties values of test objects in Object Repository during runtime? 
A. You can use SetTOProperty method of test object.Object(description).SetTOProperty Property, ValueThe values of 
test object properties are used to identify the objects. Sometimes the properties ofthe object in the application change 
dynamically. For example text of a link in a webpage is theusername used to login to that page.Text property is used by 
test object to identify the link. So in order to identify the actual object wecan manipulate the value of ―text‖ property of 
link using SetTOProperty. 
Q. How do you synchronize your scripts in QTP? 
A. For waiting until navigation of web page completes we can use Sync method. For waiting until an object appears we 
can use Exist method. For waiting until a property of object changes we can use WaitProperty method. You can set 
browser navigation timeout in: Click Test > Settings menuSelect web tab in Test Settings window. Enter the timeout in 
Browser Navigation Timeout text box. You can set global object sychrozization timeout in: Click Test > Settings menu 
Select Run tab in Test Settings window. Enter the timeout in Object Synchronization Timeout text box. 
Q Where can you write user defined functions that are accessible by all scripts? 
A. We can write user defined function in .vbs file. This file can be loaded by adding the file asfollows: Click Test > 
Settings menuSelect Resources tab in Test Settings window and add the file. Alternatively you can also load the file 
through script usingExecuteFile ―absolute or relative path of file‖ For Example: ExecuteFile ―C:\Test.vbs‖ 
Q What are regular expressions? 
A. Regular expressions used for identifying objects and text strings with varying values. You can use regular 
expressions for defining the property values of an object, creating checkpoints with varying values etc. Example: For 
example if the caption on the button in an application changes dynamically and can be anything which starts with ―Hello‖ 
(It can be Hello XYZ, Hello AB13 and so on) You can go object repository and change the value of name property of the 
button object to‖ Hello.*‖Here ―.‖ means any single character and ―*‖ means 0 or more occurrences of preceding 
character. So.* means 0 or more occurrences of any character. There are many other regular expression characters: 
For Example: Regular expression test[0-9] matches test0, test1, test2…… to test9.Regular expression abc[789] 
matches abc7, abc8, abc9Q. Different ways to parameterize tests? A. Test, action or component parameters – for using 
values from other action in your test. Data Table parameters – for creating data driven test based on values in data 
table. Environment variable parameters – For using values of environment variable. Random number parameters – For 
using random numbers as values in our test or component. 
Q. What can you do if values of object properties in an application are changing constantly? 
A. We can try using alternatives like regular expressions, Changing description of test objects in object repository during 
run time, using descriptive programming and so on. 
Q. What can you do if objects are not identified by QTP? 
A. 1) For standard windows environment you can try object mapping user defined classes to standard classes.2)You 
can find whether any addins are available for given environment.3) check if any other reliable alternatives are available 
like using keyboard shortcuts, using automation object model of application if available and so on. 
Q. What is descriptive programming? 
A. Descriptive programming allows you to work with objects that are not stored in objectrepository. two types of 
programmatic descriptions.1) listing the set of properties and values that describe the object directly in a 
teststatement.2) Add collection of properties and values to a Description object, and then enter the Description object 
name in the statement. 
Q. How will you access database from QTP? 
A. You can use ActiveX Data Object for accessing the content of database. You cancreate connection object, recordset 
object and then execute query. And access the valuesof query in recordset. 
Example Set objConn= CreateObject("ADODB.connection") 

   Set objRecSet = CreateObject("ADODB.recordset")objConn.open strConString  
'strConString is database connection string.objRecSet.open strQuery,objConn 'strQuery is SQL query to execute. 
___________________________________________________________________________________________ 
QTP: Regular expressions and Descriptive Programming  

http://qa-qtp.blogspot.com/2007/10/qtp-regular-expressions-and-descriptive.html
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what is use of regular expression in qtp ? 
The Use Of Regular Expressions In qtp Is 
Regular expressions enable QuickTest to identify objects and text strings with varying values. You can use regular 
expressions when: 
defining the property values of an object in dialog boxes or in programmatic descriptions 
parameterizing a step  
creating checkpoints with varying values  
For example, you can use a regular expression if you want to create a text checkpoint on a date text string, but the 
displayed date changes according to the current date. If you define the date as a regular expression, the checkpoint 
checks that the captured text string matches the expected date format, rather than checking the exact date value. 
You can use regular expressions only for values of type string. 
 
I am using some of the code I listed earlier in my blog to open and get the hwnd of some browser/page objects. 
However, one of the other automation engineers found an issue with my code. Apparently, the code had trouble 
opening a url like http://groups.google.com/grphp?. So, I began to work on it. QTP was returning the ever-useful 
―General Error― error, so I had to sleuth this out for myself. I am using this construct in my code to get at the handle: 
If Browser(―hwnd:=― & strBrowser).Page(―url:=― & oIE.Document.url).Exist(0) then 
strPage = Browser(―hwnd:=― & strBrowser).Page(―url:=― & oIE.Document.url).GetROProperty(―hwnd―) 
End If 
Now, the co-worker was getting the aforementioned General Error (i.e., I am broke and not smart enough to tell you 
why) on the line inside the If. So, descriptive programming worked fine to get in there. However, when it got to the line 
inside, it didn‘t. I added some code to place a ―\― in front of the ? the co-worker passed (to indicate that the ? should be 
treated literally), and it works fine. I modified the code I now use to look for this issue and correct it without direction. 
My only issue is: why the heck did it work fine on the Exist line, but not the GetROProperty line? 
Lesson learned: be mindful of regular expressions in your descriptive programming. 

 
Quick Test Notes  
There are 2 ways of testing   -    1. Manual testing  2. Automation testing 
 
1. Manual testing 
It is a process in which all the phases of software testing life cycle like test planning test development, test execution, 
result analysis, bug tracking and reporting are accomplished successfully manually with human efforts. 
Drawbacks of manual testing 
1. More no. of people are required 
2. Time consuming 
3. Human errors 
4. Tired ness 
5. Repeating the things is critical 
6. simultaneous actions are not possible 
 
2. Automation test 
It is a process in which all the drawbacks of manual testing are addressed properly and provide speed and accurate to 
existing testing process. 
Note: Automation testing is not a replacement of manual testing 
―Automation tool is an assistant of an a test engineer‖ 
Journal framework: – To learn any automated tool: 
A test engineer should know the following things to work with any automated tool 
1. How to give the instructions 
2. How to give the information 
3. How to use its recording facility 
4. How to make the tool repeats the action 
5. How to analyze the result 
Types of automated tools: – There are 3 types of automated tools 
1. Functional tool (qtp, Win runner) 
2. Management Tool (Quality Center or Test Director) 
3. performance Tool (Load Runner) 
Quick Test Professional (QTP) 
History of QTP 
Type of the tool functional tool 
Company: Mercury Interactive incorporation 
Initial Versions: 5.5, 7.6, 8.0, 8.2, 9.0, and 9.1. 
Operating systems for QTP: Win 2000 server, advanced server and 2000proressional 
Ex:1 Vbwindow(―Emp‖).vbedit(―Emp name‖).set ―prasanna‖ 
             Vbwindow(―Emp‖).vbedit(―Emp age‖).set ―20‖ 

http://groups.google.com/grphp
http://qa-qtp.blogspot.com/2007/10/quick-test-pro.html
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             Vbwindow(―Emp‖).vbedit(―Emp sal‖).set‖25000‖ 
             Vbwindow(―Emp‖).vbedit(―Emp desg‖).set‖Tester‖ 
             Vbwindow (―Emp‖).vbbutton(―submit‖). Click 
EX: 2 
Vbwindow(―form1‖).vbedit(―val1‖).set‖10‖ 
Vbwindow(―form1‖).vbedit(―val2‖).set‖20‖ 
Vbwindow(―form1‖).vbbutton(―sub‖).click 
Vbwindow(―form1‖).vbbutton(―mul‖).click 
Vbwindow(―form1‖).vbbutton(―div‖).click 
Vbwindow(―form1‖).vbbutton(―clear‖).click 
 
Anatomy or QTP: – 
 
Ad-inn Manager: – It is a feature provided by qtp used for making the qtp compatible with a specified environment by 
default the qtp provides 3 add-ins 
1. Visual Basic 
2. Activex 
3. Web 
Apart from these 3 add-ins qtp is always compatable with standard windows environment 
QTP serene is divided in to 5 parts 
1. Test pane area 
2. Active Screen 
3. Data table 
4. Debug weaver pane 
5. Tool option 
 
1. Test pane:– It is an area provided by QTP used for viewing the text script. It also allows the user to do any kind of 
modifications on the text script. 
Test pane represents the script in 2 ways. 
² Expert View 
² Keyword View 
 
a. Expert View:–Expert view represents the script in vb script format. 
b. Keyword View:–It is represents the script using a graphical user interface which is divided in to 4 Parts. 
± Item 
± Operation 
± Value 
± Documentation 
 
2. Active screen:–It is a feature provided by QTP which holds the snap shots of application state of each and every 
script statement. 
Features:– 
It is used for understand the script easily. 
It is used for enhancing the script easily. 
 
3. Datatable:– It is also called as formula one sheet developed by the 3rd party and integrated with the QTP. 
 
Features:– 
- It is used for holding the test data. 
- It provides a facility to import the test data from different data sources like database, excel sheet or flat file. 
- It allows the user to enter the data and modify the data directly in it. 
- It isolates the text script from the data source. 
 
QTP maintain 2 copies of data tables 
1. Design time datatable 
2. Run time datatable 
 
4. Debug Viewer pane:– It is used for viewing, modifying, or setting the current values of the variables and command 
tabs. 
5. Too potion:– The option that are available in menu bars and tools are known as tool options. 
 
Recording and running 
 
Record and run settings:– It is a feature provided by QTP used for making the QTP aware on which applications a test 
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engineer is about to perform record and run operations. 
 
A test engineer has to compulsorily use this option for every new test. For doing the same this feature has provided 2 
Options. 
 
o Record and run on any open windows application 
o Record and run on these applications 
 
Navigations 
ü Activate the menu item test 
ü Select the option record and run settings 
ü Select one of the following action 
o Record and run on any open windows application 
o Record and run on these applications 
ü If at all the second option is selected click on add button 
ü Browse the desire file to be added 
ü Click on ok 
ü Click on apply and ok. 
 
Operational Overview of recording: 
During recording the QTP will be doing the following things. 
v Every user action is converted in to script statement 
v The corresponding object information is stored in the object repository. 
 
Operational Overview of running: 
v QTP tries to understand the script statement 
v After understanding what action to be performed or which object is realized that it needs to identify that object. 
v In order to identify the object it needs the corresponding information. 
v For that it will go to the object repository and search for the information. 
v If at all the information is found using that information it will try to identify the object. 
v If at all the object is identified then it will perform the action 
 
Types of Recording Modes 
 
1. Context sensitive recording mode:– It is used for recording the operations perform on the standard GUI objects. 
2. Analog Recording:– It is a special recording mode provided by QTP to record the continuous actions performed on 
the application. 
3. Low level recording:– It is used for recording at least minimum operations on the applications which are developed 
with known supported environment. 
 
Navigation 
ü Keep the tool under normal recording mode 
ü Activate the menu item text 
ü Select the option analog recording 
ü Select one of the following actions. 
o Record relative to the screen. 
o Record relative to the following window. 
 
If at all the second option is selected specify the window title using the hand icon C 
Click on start analog record button. 
 
OBJECT REPOSITORY 
 
It is storage place where one can store the objects information and it also acts as a interface between the text script 
and the AUT in order to identify the object during execution. 
 
Types Of Object Repository 
There are 2 types of object repository. 
1. per-action object repository:– 
For each and every action in a test the QTP will create and manage the individual repository. 
Dis Advantage: Difficult to maintenance 
2. shared repository:– 
It is a Common place where one can store the objects information and it can be associated to multiple tests. 
Advantage: Easy to maintenance and can be used by multifull test case 
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Note: The shared repository has to be created manually and associated manually to the test. 
Object Identification:- 
It is a concept is based on four types of properties and ordinal identifier. 
Type of properties: 
1. Mandatory property 
2. Assistive property 
3. Base filter property 
4. Optional filter property 
A test engineer can specify list of Mandatory, Assistive, Base filter, and Optional filter properties. 
 
QTP Learns The Properties In The Following Sequence 
 
1 First of all QTP learns the complete list of mandatory properties and then it will check whether these properties are 
sufficient for identifying the objects uniquely. 
2 If it sufficient it will stop learning otherwise it will learn the first assistive properties and then it will once again check 
whether these properties are sufficient are identifying the object uniquely. 
3 If it feels not sufficient then it will learn the second assistive properties once again it will check whether these 
properties are sufficient if it feels not sufficient the above processor continue till the QTP feels satisfied or up to the 
end of the assistive properties list. 
4 If it is still feels not sufficient then it will learn the ordinal identifier. 
 
Note1 
If at all the smart identification mechanism is invoked then the QTP will learn the information as same as above but 
with mandatory properties it will also learn base filer properties and optional filter properties even though it learn the 
BFP and OFP it will not consider them while learning, just it learns and store them secretly in the object repository. 
 
Note2 
Other then BFP and OFP all the remaining properties and ordinal identifier will be stored in the object repository. 
 
QTP uses the information in order to identify the object during execution in the following way 
First of all QTP will consider all the properties present in the object repository( i.e., Mandatory properties , optional, 
Assistive properties) and tries to identify the object if it fails then it will use the smart identification mechanism in the 
following way. 
 
It will consider the complete list of base filter properties and prepares the list of objects which are matched with all 
these properties. If at all the list contains only one object then that is the object, otherwise it will take the help of first 
optional filter properties and prepares a new list of objects which are matched with this ofp (Optional Filter Properties), 
If at all the list contains more then one object it will consider the second optional filter properties and tries to match 
with all the objects present in the new list. The object that are not matched will be filtered and a new list objects is 
formed if at all the new list is containing more then one object then it will proceed with the above procedure till the list 
contains one object or up to the end of the ofp list. It still qtp is unable to identify the object, if at all the ordinal identifier 
is learned then it will use the ordinal identifier and identify the object. 
 
Ordinal Identifier 
There are 3 Types of Ordinal identifiers. 
1. Location 
2. Index 
3. Creation time 
 
1. Location 
QTP will generate sequence of numbers from 1,2,3,4…based on the sequence of the object located in the AUT 
2. Index 
QTP will generate sequence number from 0,1,2,3.. based on the sequence of the program written for those objects. 
3. Creation Time 
QTP will generate the sequence of number from 0,1,2,3.. based on the loading time of the web pages. 
 
Object Spy 
It is a feature provided by QTP which shows the complete object information like list of properties, list of methods, 
syntax of methods and description of methods for both test objects as well as run time objects on the spot 
immediately. 
 
QTP LIFE CYCLE 
 
1. Test Planning 
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2. Generating basic test 
3. Enhancing the test 
4. Debugging the test 
5. Executing the test 
6. Analyzing the results 
 
1. test planning 
The automation test lead will do the following in this phase. 
He will understand the requirements. 
He will identify the areas to be automated. 
He will analyze both the positive and negative flow of the application. 
Based on all these analysis he will prepare the test plan. 
He will prepare the tool ready with all pre configurationally settings for further operations. 
 
2. generate the basic test 
A test engineer will generate the basic test for both the positive and negative flow of the application. 
3. Enhancing the test 
One can enhance the test on the following ways. 
ð Inserting the checkpoints. 
ð Synchronizing the test 
ð Parametarising the test (Data driven testing) 
ð Inserting the output Values 
ð Measuring transactions 
ð Enhancing the test with programmatic statement 
ð Adding comments 
ð Inserting the script statements manually. 
 
ð Inserting the checkpoints:- 
―Checkpoint‖ is defined as validation point or test point which checks the object state or bit map state or data state 
during the execution phase at any point of time. 
Operational overview of checkpoint 
Check point works in 2 phases. 
1. pre execution phase Capture the expected value, Generate the basic test 
2. While execution phase Capture the actual value with the expected value displays the result. 
types of checkpoints 
· Standard checkpoints 
· Bit map checkpoints 
· Text checkpoints 
· Text area checkpoints 
· Database checkpoints 
· XML checkpoints 
· Page checkpoints 
· Table checkpoints 
· Image checkpoints 
· Accessibility checkpoints 
 
· Standard Checkpoints: – Standard checkpoint is used for checking the properties values of standard GUI objects. 
Navigation through Application 
ü Keep the tool under recording mode 
ü Activate the menu item insert 
ü Go to checkpoint 
ü Select the option standard checkpoint 
ü Click on the desired object 
ü Ensure that the corresponding object is selected in the object hierarchy and click on ok. 
ü Select the desired properties to be checked EX. Width and height.. 
ü Stop recording. 
 
Navigation through Active Screen 
ü Keep the curser on the desired statement so that the corresponding snap shot is available in the active screen. 
ü Go to active screen 
ü Right click on the desired object select the option insert standard checkpoint. 
ü Ensure that the corresponding object is selected in the object hierarchy and click on ok. 
ü Select the desired propertied to be checked ex: X,Y and width and height. 
ü Select one of the following options. 
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à Before current step 
à After current step 
ü Click on ok 
 
· Bit map checkpoint: –It is used for checking the complete bitmaps or part of the bit maps 
· Text check point: – It is used for checking the text present on a specified object. 
· Text area checkpoint: – It is used for checking the text present in a specified area 
Note: Text area checkpoint cannot insert through active screen it can be inserted only through application. 
· Database checkpoint: – It is used for checking the contains of a database. 
· Xml Checkpoint: – xml is a universal understandable language used for data transformation. 
Xml checkpoint is used for checking the contents of al xml file. 
· Page checkpoint: – It is used for checking the properties of a page like load time number of images and number of 
links. 
· Table checkpoint: – It is used for checking the contents of al web table 
· Image checkpoint: – It is used for checking the properties of an image. 
· Accessibility checkpoint: – It is used to checking the www.(world wide web) consortium standards. 
 
ð Synchronizing the test 
It is a process of matching the speeds of both the tool and application in order to keep them in sync with each other to 
obtain proper results. 
Here the main concept is making the tool to wait till the application finishes the task. 
This can do it 3 ways. 
1. Inserting the synchronization point. 
2. Inserting the wait statement. 
3. Increasing the default time. 
 
Navigation for inserting synchronization point 
ü Keep the curser under desired location 
ü Keep the tool under recording mode 
ü Activate the menu item insert. 
ü Go to step and select the option synchronization point. 
ü Click on the desired object ensure that the corresponding object is selected in the object hierarchy and click on ok. 
ü Specify the desired property name and value (true) specify the extra time in milliseconds. 
ü Click on ok. 
ü Stop recording. 
In order to avoid the above navigation one can directly insert the following statement in the script in desired location. 
Syntax – 
object hierarchy. wait property ―wait property name‖ ―property value‖, extra time in milliseconds. 
Ex–windows.(―Flight reservation‖).winbutton (―delete order‖).wait property ―enable‖ , true,10000. 
 
Wait statement 
It is used for making the tool to wait till the specified time is elapsed. 
Syntax – wait (20) time in seconds. 
 
Navigation for Increasing the Default Time 
ü Activate the menu item test 
ü Select the option settings and go to run tab 
ü Specified the desired time in mille seconds in object synchronization time out field. 
ü Click on apply and ok 
 
Parameterising The Test Or Data Driven Testing:- 
Data driven testing is a concept provided in QTP in order to implement retesting. 
Navigation for data driven testing 
ü Collect the required data into the data table 
ü Generate the basic test 
ü Parameterize the test 
ü Analysis the result 
Parameterization 
It is a process of replacing the consistence values with parameters or variables in order to increase the scope of the 
test 
Parameterization can be done in 3 ways 
1. Data Driven wizard 
2. Keyword view 
3. Manual view 
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Navigation through data driven wizard 
ü Activate the menu item tools 
ü Select the option data driven 
ü Select the desired consistent value to be parameterize 
ü Click on parameterize button 
ü Click on next 
ü Click on parameter option button 
ü Specify the desired column name 
ü Click on ok and finish 
Navigation through keyword view 
ü Go to keyword view 
ü Select the desired consistent value 
ü Click on the configure value button 
ü Select the option parameter 
ü Specify the desired column name 
ü Click on ok 
 
In order to avoid the above navigation one can directly write the script in the following way. 
Vbwindow(―form1‖).vbedit(―val1‖).setdatatable(―v1‖,1‖) 
Vbwindow(―form1‖).vbedit(―val2‖).setdatatable(―v2‖,1‖) 
Vbwindow(―form1‖).vbbutton(―add‖).click 
Vbwindow(―form1‖).vbedit(―res‖).checkpoint(―res‖) 
Navigation For Parameterizing the Checkpoint 
ü Right click on the checkpoint statement. 
ü Select the option checkpoint properties 
ü Select the desired property whose value to be parameterize 
ü Select the option parameter 
ü Click on parameter button 
ü Specify the desired column name 
ü Click on ok 
Ex: Object hierarchy, setdatatable (ordno,‖1‖) 
 
Output Value 
It is feature provide by QTP used for capturing a value from the application or from the database or from the xml file 
during execution and store in under a specified column in the run time data table. 
Operational Overview Of Output Value 
It is divided in to 2 phases. 
1. pre-execution phase 
2. while- execution phase 
1. pre execution phase – Capture the field name whose value is to be captured 
2. While execution phase – Capture the actual value from the field and stores the captures value under a specified 
column in the run time data table. 
Types Of Output Values 
1. Standard output value 
2. Text output value 
3. Text area output value 
4. Data table output value 
5. XML output value 
 
Navigation for Output Value 
ü Keep the tool under recording mode 
ü Activate the menu item insert and go to output value and select standard output value 
ü Click on the specified object or field 
ü Click on ok 
ü Select the desired property value whose value to be captured. 
ü Click on modify button and specify the desired column name. 
ü Click on ok, click on ok 
 
Measuring Transactions 
It is a concept provided by QTP in order to calculate the execution taken by a block of statement or the time taken by 
an application to accomplish a task. 
To do the same QTP has provided 2 options 
1. Start transaction 
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2. End transaction 
 
Navigation for Inserting the start transaction 
ü Keep the curser in the desired location 
ü Activate the menu item insert 
ü Select the option start transaction 
ü Specify the desired name (any thing) 
ü Select one of the following option 
à Before current step 
à After current step 
ü Click on ok 
 
In order to avoid the above navigation one can insert the following statements directly in the script 
EX: Services. Start transaction ―trans‖ 
 
 
Services.end transction ―trans‖ 
Inserting the Programmatic Statement 
Programmatic statements are 5 types 
1. Normal statement or object 
2. Conditional state 
3. Comments 
4. Utility statements 
 
Navigation 
ü Go to keyword view 
ü Activate the menu item insert go to step 
ü Select the desired option 
 
Repository Utility Object 
It is used for reporting a user defined massage to the result window. 
Syntax – 
Reporter.reportevent mic(status), ―reportname‖ ―message‖ 
Ex:– This program is demo for looping and constituent 
For i=1 to 10 
If (i=10) then 
Message box ―hai‖ 
Reporter.reportevent micpass, ―myrep‖,‖con is satisfied‖ 
else 
Msgbox ―bye‖ 
Reporter. Reportevent micfail, ―myrep‖, ―cond is not satisfied‖ 
End if 
Next 
Quick Test Pro FAQ'S  
If an application name is changes frequently i.e while recording it has name, in this case how does QTP handles? 
 
IF we use batch testing. the result shown for last action only.in that how can i get result for every action. 
You can click on the icon in the tree view to view the result of every action 
WinRunner Compared to QuickTest Pro 
Environment Coverage Comparison: 
Common environments shared by both WinRunner and QuickTest Pro: 
Web-Related Environments 
IE, Netscape, AOL 
 
JDK, Java Foundation Classes, AWT 
 
Symantec Visual Café 
 
ActiveX Controls 
ERP/CRM 
Oracle: Jinitiator, 11i, NCA 
Custom Client Server 
Windows 
 

http://qa-qtp.blogspot.com/2007/10/quick-test-pro-faqs.html
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C++/C 
Visual Basic 
Operating Systems 
Windows 98, 2000, NT, ME, XP 
Legacy 
3270, 5250 Emulators 
 
VT100 
WinRunner Only Environments: 
Custom Client/Server 
PowerBuilder 
 
Forte 
 
Delphi 
 
Centura 
 
Stingray 
 
SmallTalk 
ERP/CRM 
Baan 
 
PeopleSoft Windows 
 
Siebel 5, 6 GUI Clients 
 
Oracle GUI Forms 
 
QuickTest Pro Only Environments: 
ERP/CRM 
SAP 
 
Siebel 7.x 
 
PeopleSoft 8.x 
.Net 
WinForms 
 
WebForms 
 
.Net controls 
Web Services 
XML, HTTP 
 
WSDL, SOAP 
 
J2EE, .Net 
Multimedia 
RealAudio/Video 
 
Flash 
 
Feature Comparison: 
Common features found in both WinRunner and QuickTest Pro: 
Record/Replay 
ODBC & Excel Connectivity 
Code Editor & Debugger 
Recovery Manager 
Shared Object Repository 
Rapid Object Import 
Numerous Checkpoints 
Analog 
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Script & Function Libraries 
 
WinRunner Only Environments: 
Function Generator 
Database Integration 
Run Wizard 
TSL 
MDI 
QuickTest Pro Only Environments: 
ActiveScreen, TestGuard Tree View ScriptFusion Data Table VBScript Function Generator* (coming in v7.0) Run 
Wizard* (coming in v7.0). 
How to Import data from a ".xls" file to Data table during Runtime. 
Datatable.Import "...XLS file name..."DataTable.ImportSheet(FileName, SheetSource, SheetDest) 
DataTable.ImportSheet "C:\name.xls" ,1 ,"name" 
How to export data present in Datatable to an ".xls" file? 
DataTable.Export "....xls file name..." 
Syntact for how to call one script from another? and Syntax to call one "Action" in another? 
RunAction ActionName, [IterationMode , IterationRange , Parameters]Here the actions becomes reusable on making 
this call to any Action.IterationRange String Not always required. Indicates the rows for which action iterations will be 
performed. Valid only when the IterationMode is rngIterations. Enter the row range (i.e. "1-7"), or enter rngAll to run 
iterations on all rows.If the action called by the RunAction statement includes an ExitAction statement, the RunAction 
statement can return the value of the ExitAction's RetVal argument. 
How to export QTP results to an ".xls" file? 
By default it creates an "XML" file and displays the results 
How the exception handling can be done using QTP 
It can be done Using the Recovery Scenario Manager which provides a wizard that gudies you through the process of 
defining a recovery scenario. FYI.. The wizard could be accesed in QTP> Tools-> Recovery Scenario Manager ....... 
How many types of Actions are there in QTP? 
There are three kinds of actions:non-reusable action—an action that can be called only in the test with which it is 
stored, and can be called only once. reusable action—an action that can be called multiple times by the test with 
which it is stored (the local test) as well as by other tests.external action—a reusable action stored with another test. 
External actions are read-only in the calling test, but you can choose to use a local, editable copy of the Data Table 
information for the external action. 
Analyzing the Checpoint results 
Standard Checpoint :By adding standard checkpoints to your tests or components, you can compare the expected 
values of object properties to the object's current values during a run session. If the results do not match, the 
checkpoint fails. 
How to handle Run-time errors? 
On Error Resume Next : causes execution to continue with the statement immediately following the statement that 
caused the run-time error, or with the statement immediately following the most recent call out of the procedure 
containing the On Error Resume Next statement. This allows execution to continue despite a run-time error. You can 
then build the error-handling routine inline within the procedure.Using "Err" object msgbox "Error no: " & " " & 
Err.Number & " " & Err.description & " " & Err.Source & Err.HelpContext 
What are the different scripting languages you could use when working with QTP ? 
Visual Basic (VB),XML,JavaScript,Java,HTML 
How to handle dynamic objects in QTP? 
QTP has a unique feature called Smart Object Identification/recognition. QTP generally identifies an object by 
matching its test object and run time object properties. QTP may fail to recognise the dynamic objects whose 
properties change during run time. Hence it has an option of enabling Smart Identification, wherein it can identify the 
objects even if their properties changes during run time. Check this out-If QuickTest is unable to find any object that 
matches the recorded object description, or if it finds more than one object that fits the description, then QuickTest 
ignores the recorded description, and uses the Smart Identification mechanism to try to identify the object. While the 
Smart Identification mechanism is more complex, it is more flexible, and thus, if configured logically, a Smart 
Identification definition can probably help QuickTest identify an object, if it is present, even when the recorded 
description fails.The Smart Identification mechanism uses two types of properties:Base filter properties—The most 
fundamental properties of a particular test object class; those whose values cannot be changed without changing the 
essence of the original object. For example, if a Web link's tag was changed from to any other value, you could no 
longer call it the same object. Optional filter properties—Other properties that can help identify objects of a particular 
class as they are unlikely to change on a regular basis, but which can be ignored if they are no longer applicable. 
Explain the keyword createobject with an example. 
Creates and returns a reference to an Automation objectsyntax: CreateObject(servername.typename [, 
location])Argumentsservername:Required. The name of the application providing the object.typename : Required. The 
type or class of the object to create.location : Optional. The name of the network server where the object is to be 
created. 
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What is a Run-Time Data Table? Where can I find and view this table? 
-In QTP, there is data table used , which is used at runtime.-In QTP, select the option View->Data tabke.-This is 
basically an excel file, which is stored in the folder of the test created, its name is Default.xls by default. 
How to do the scripting. Is there any inbuilt functions in QTP as in QTP-S. Whatz the difference between 
them? how to handle script issues? 
Yes, there's an in-built functionality called "Step Generator" in Insert->Step->Step Generator -F7, which will generate 
the scripts as u enter the appropriate steps. 
What is the difference between check point and output value. 
An outPut value is a value captured during the test run and entered in the run-time but to a specified location. EX:-
Location in Data Table[Global sheet / local sheet] 
Types of properties that Quick Test learns while recording? 
(a) Mandatory (b) Assistive . In addition to recording the mandatory and assistive properties specified in the Object 
Identification dialog box, QuickTest can also record a backup ordinal identifier for each test object. The ordinal 
identifier assigns the object a numerical value that indicates its order relative to other objects with an otherwise 
identical description (objects that have the same values for all properties specified in the mandatory and assistive 
property lists). This ordered value enables QuickTest to create a unique description when the mandatory and assistive 
properties are not sufficient to do so. 
Differences between QTP & Winrunner? 
(a) QTP is object bases Scripting ( VBS) where Winrunner is TSL (C based) Scripting.(b) QTP supports ".NET" 
application Automation not available in Winrunner(c) QTP has "Active Screen" support which captures the application, 
not available in WR.(d) QTP has "Data Table" to store script values , variables which WR does not have.(e) Using a 
―point and click‖ capability you can easily interface with objects, their definitions and create checkpoints after having 
recorded a script – without having to navigate back to that location in your application like you have to with 
WinRunner. This greatly speeds up script development. 
Few basic questions on commonly used Excel VBA functions. 
common functions are:Coloring the cellAuto fit cellsetting navigation from link in one cell to other saving 
How does Parameterization and Data-Driving relate to each other in QTP? 
To datadrive we have to parameterize.i.e. we have to make the constant value as parameter, so that in each 
iteraration(cycle) it takes a value that is supplied in run-time datatable. Through parameterization only we can drive a 
transaction(action) with different sets of data. You know running the script with the same set of data several times is 
not suggestable, & it's also of no use. 
What is the difference between Call to Action and Copy Action.? 
Call to Action : The changes made in Call to Action , will be reflected in the orginal action( from where the script is 
called).But where as in Copy Action , the changes made in the script ,will not effect the original script(Action) 
How to verify the Cursor focus of a certain field? 
Use "focus" property of "GetRoProperty" method" 
Any limitation to XML Checkpoints? 
Mercury has determined that 1.4MB is the maximum size of a XML file that QTP 6.5 can handle 
How to make arguments optional in a function? 
this is not possible as default VBS doesn't support this. Instead you can pass a blank scring and have a default value 
if arguments r not required. 
How to add a text checkpoint to your test to check whether 'welcome' is displayed in your welcome page. 
1 Locate the page where you want to add a text checkpoint.2 Create a text checkpoint.In the Active Screen, under 
your page highlight the text welcome. Right-click the highlighted text and choose Insert Text Checkpoint. The Text 
Checkpoint Properties dialog box opens.When Checked Text appears in the list box, the Constant field displays the 
text string you highlighted. This is the text QuickTest looks for when running the test.Click OK to accept the default 
settings in this dialog box.QuickTest adds the text checkpoint to your test. It is displayed in the Keyword View as a 
checkpoint operation on your welcome page3 Save the test. 
How to Running and Analyzing a Test with Checkpoints? 
1 Expand the test and review your test.Choose View > Expand All or use the * shortcut key on your number keypad. 2 
Start running your test.Click Run or choose Test > Run. The Run dialog box opens. Ensure that New run results folder 
is selected. Accept the default results folder name. Click OK. When the test run is completed, the Test Results window 
opens. 3 View the test results.When QuickTest finishes running the test, the Test Results window opens. The test 
result should be Passed, indicating that all checkpoints passed. If one or more checkpoints had failed, the test result 
would be Failed. 4 View the results of the page checkpoint.In the Details pane, you can review the details of the page 
checkpoint, which lists the items checked. 5 View the results of the table checkpoint.In the Details pane, you can 
review the details of the table checkpoint. You can also review the values of the table cells (cell values that were 
checked are displayed in black; cell values that were not checked are displayed in gray). 6 View the results of the 
standard checkpoint.In the Details pane, you can review the details of the standard checkpoint, which lists the 
properties that were checked and their values. The checkpoint passed because the actual values of the checked 
properties match the expected values. 7 View the results of the text checkpoint.In the Details pane, you can review the 
details of the text checkpoint. The checkpoint passed because the actual text matches the expected text. 8 Close the 
Test Results window. Choose File > Exit. 
How to Defining a Data Table Parameter for QTP? 
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1 Start QuickTest and open the Checkpoint test.2 Save the test as Parameter.3 Confirm that the Active Screen option 
is enabled.4 Confirm that the Data Table option is enabled.5 Select the text to parameterize.6 Set the 
parameterization properties. 
How to add a runtime parameter to a datasheet? 
DataTable.LocalSheetThe following example uses the LocalSheet property to return the local sheet of the run-time 
Data Table in order to add a parameter (column) to it.MyParam=DataTable.LocalSheet.AddParameter("Time", "5:45") 
How to change the run-time value of a property for an object? 
SetTOProperty changes the property values used to identify an object during the test run. Only properties that are 
included in the test object description can be set 
How to retrieve the property of an object? 
using "GetRoProperty". 
How to open any application during Scripting? 
SystemUtil , object used to open and close applications and processes during a run session.(a) A SystemUtil.Run 
statement is automatically added to your test when you run an application from the Start menu or the Run dialog box 
while recording a testE.g : SystemUtil.Run "Notepad.exe" SystemUtil.CloseDescendentProcesses ( Closes all the 
processes opened by QTP ) 
How to covert a String to an integer? 
CInt()---> a conversion function available. 
Inserting a Call to Action is not Importing all columns in Datatable of globalsheet. Why? 
Inserting a call to action will only Import the columns of the Action called 
Differentiate the two Object Repository Types of QTP. 
Object repository is used to store all the objects in the application being tested.2 types of oject repositoy per action 
and shared. In shared repository only one centralised repository for all the tests. where as in per action.for each test a 
separate per action repostory is created. 
What the differences are and best practical application of each. 
Per Action: For Each Action, one Object Repository is created. Shared : One Object Repository is used by entire 
application 
Explain what the difference between Shared Repository and Per_Action Repository 
Shared Repository: Entire application uses one Object Repository , that similar to Global GUI Map file in WinRunner 
Per Action: For each Action ,one Object Repository is created, like GUI map file per test in WinRunner 
Have you ever written a compiled module? If yes tell me about some of the functions that you wrote. 
I Used the functions for Capturing the dynamic data during runtime. Function used for Capturing Desktop, browser 
and pages. 
What projects have you used WinRunner on? Tell me about some of the challenges that arose and how you 
handled them. 
pbs :WR fails to identify the object in gui. If there is a non std window obk wr cannot recognize it ,we use GUI SPY for 
that to handle such situation. 
Can you do more than just capture and playback? 
I have done Dynamically capturing the objects during runtime in which no recording, no playback and no use of 
repository is done AT ALL. -It was done by the windows scripting using the DOM(Document Object Model) of the 
windows. 
Summary: QuickTest Pro 
Summary:QuickTest Professional provides an interactive, visual environment for test development.Here is the 
description from the Mercury Interactive ―How it Works‖ section of the QuickTest Pro web page:Mercury QuickTest 
Professional™ allows even novice testers to be productive in minutes. You can create a test script by simply pressing 
a Record button and using an application to perform a typical business process. Each step in the business process is 
automated documented with a plain-English sentence and screen shot. Users can easily modify, remove, or rearrange 
test steps in the Keyword View.QuickTest Professional can automatically introduce checkpoints to verify application 
properties and functionality, for example to validate output or check link validity. For each step in the Keyword View, 
there is an ActiveScreen showing exactly how the application under test looked at that step. You can also add several 
types of checkpoints for any object to verify that components behave as expected, simply by clicking on that object in 
the ActiveScreen.You can then enter test data into the Data Table, an integrated spreadsheet with the full functionality 
of Excel, to manipulate data sets and create multiple test iterations, without programming, to expand test case 
coverage. Data can be typed in or imported from databases, spreadsheets, or text files.Advanced testers can view 
and edit their test scripts in the Expert View, which reveals the underlying industry-standard VBScript that QuickTest 
Professional automatically generates. Any changes made in the Expert View are automatically synchronized with the 
Keyword View.Once a tester has run a script, a TestFusion report displays all aspects of the test run: a high-level 
results overview, an expandable Tree View of the test script specifying exactly where application failures occurred, the 
test data used, application screen shots for every step that highlight any discrepancies, and detailed explanations of 
each checkpoint pass and failure. By combining TestFusion reports with Mercury Quality Management, you can share 
reports across an entire QA and development team.QuickTest Professional also facilitates the update process. As an 
application under test changes, such as when a ―Login‖ button is renamed ―Sign In,‖ you can make one update to the 
Shared Object Repository, and the update will propagate to all scripts that reference this object. You can publish test 
scripts to Mercury Quality Management, enabling other QA team members to reuse your test scripts, eliminating 
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duplicative work.QuickTest Professional supports functional testing of all popular environments, including Windows, 
Web, .Net, Visual Basic, ActiveX, Java, SAP, Siebel, Oracle, PeopleSoft, terminal emulators, and Web services.- 
QuickTest Pro ―How it Works‖ webpage from Mercury:http://www.mercury.com/us/products/quality-center/functional-
testing/quicktest-professional/works.htmlWe like QuickTest Pro and now prefer implementing it over WinRunner. 
When you get into advance testing scenarios, QuickTest Pro has more options and they are easier to implement 
compared to WinRunner in our opinion.Do to the similarities in concept and features, an experienced WinRunner user 
can easily convert to QuickTest Pro and quickly become an efficient Test Automation Engineer!We recommend that 
existing customers begin all new development with QuickTest Pro and use the built-in feature of calling WinRunner 
scripts from QuickTest Pro for all existing WinRunner scripts that they already have. As older scripts require updates 
and time permits, we recommend replacing them with QuickTest Pro scripts.  
Eventually you will be able to convert your test script library with all QuickTest Pro scripts.Pros: 
* Will be getting the initial focus on development of all new features and supported technologies. 
* Ease of use. 
* Simple interface. 
* Presents the test case as a business workflow to the tester (simpler to understand). 
* Numerous features. 
* Uses a real programming language (Microsoft‘s VBScript) with numerous resources available. 
* QuickTest Pro is significantly easier for a non-technical person to adapt to and create working test cases, compared 
to WinRunner. 
* Data table integration better and easier to use than WinRunner. 
* Test Run Iterations/Data driving a test is easier and better implement with QuickTest. 
* Parameterization easier than WinRunner. 
* Can enhance existing QuickTest scripts without the ―Application Under Test‖ being available; by using the 
ActiveScreen. 
* Can create and implement the Microsoft Object Model (Outlook objects, ADO objects, FileSystem objects, supports 
DOM, WSH, etc.). 
* Better object identification mechanism. 
* Numerous existing functions available for implementation – both from within QuickTest Pro and VBScript. 
* QTP supports .NET development environment (currently WinRunner 7.5 does not). 
* XML support (currently WinRunner 7.5 does not). 
* The Test Report is more robust in QuickTest compared to WinRunner. 
* Integrates with TestDirector and WinRunner (can kick off WinRunner scripts from QuickTest).Cons: 
* Currently there are fewer resources (consultants and expertise) available due to QTP being a newer product on the 
market and because there is a greater Demand than Supply, thus fewer employee/consulting resources. 
* Must know VBScript in order to program at all. 
* Must be able to program in VBScript in order to implement the real advance testing tasks and to handle very 
dynamic situations. 
* Need training to implement properly. 
* The Object Repository (OR) and ―testing environment‖ (paths, folders, function libraries, OR) can be difficult to 
understand and implement initially.  
QuickTest Pro Questions Only  
1. how many maximum actions can be performed in a single test 2. How to create the dynamic object repository in 
QTP?  
3. What is difference between global sheet anh action sheet?  
4. How to pass parameters from one action to another action.  
5. How to perform Cross platform testing and Cross browser testing using QTP?Can u explain giving some exampl  
6. how to connect the database through QTP  
7. How to open multiple instances of an application from QTP? 2. How to recognize each instance and setting  
8. This is the chain of question#: 15434What conditions we go for Reusable Scripts and how we create and  
9. Can we call QTP test from another test using scripting.Suppose there are 4 tests and i want to call these 10. Is it 
possible to test a web application(java) with winrunner?otherwise is it possible to check with  
11. How can we insert Text check point and Bit map check point ? if provide example script, it is greatefu  
12. Can we mask a Code In .vbs file so that it is not viewable to others?  
13. Is there any function to double click a particular row in a webtable?  
14. what is the use of command tab in Debug viewer ?can we execute any user defined queries  
15. What is Analog recording,What is the difference between analog recording and low level recording  
16. what is database check point.  
17. What is the use of function and sub function in QTP?  
18. What is the new Version of QTP which is recently released in the Market?  
19. How to call a funtion present in dll file in QTP Script.  
20. I have n iterations of test run in QTP. I want to see the results of not only the latest (‗n‘th) iteration  
21. How to call from one action to another action in QTP?  
22. What is the Difference Between Bit map Check point & Image Check pointPlease explain in detailText &  
23. How can we do block commenting in QTP?  
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24. How to get the column count and column name from resultset in database connction program?  
25. 1. How to write QTP scripts?2. Any related website resource to learn QTP?3. What steps the to be follwed  
26. How to check an XML schema (XML Schema Validation--from XML file)? Ttell me about .XSD file format.  
27. How to schedule tests in QTP?  
28. Is Addins enough to work in Flex based applications? or do we have to get a licence for multimedia for  
29. how to identify a 'web element' class object while recording and running in 'Event' mode of settings.  
30. What are the new features available in QTP 8.2 compared with earlier versions?  
31. Hi forum. Could any body tell me what is AMDOCS, and what are its models ? Best regrds.  
32. What is difference between window(" ") and dialog(" ") in QTP while creating script?  
33. How do you retrieve the Class name of a Test Object programmatically from within a script?  
34. What is the best way to test UNIX (QTP, Winrunner or Xrunner)? If QTP supports let me know the brief  
35. What is the Recovery Scenerio can apllied for any telephone line connection(Ex:BSNl,Airtel etc  
36. what are advantages and disadvantages between internet explorer and netscape navigator (or) Internet 37. 
Anybody with an experience of testing Mainframe applications. I usually check the ActiveX and VB add-ins  
38. Difference Between text and Text area checkpoints in QTP  
39. How to Handle dynamic WebList in QTP...Values in Weblist are different  
40. What is the Hotkey that can be used for Hitting spacebar?  
41. We are trying to avoid that anybody see our script after we wrote it. Did anybody know how to do this?  
42. how can i insert database checkpoint in qtp-6.5  
43. What are different execution modes available in QTP & explain them.  
44. How can we recognize objects in Flex application using QTP? When I record scripts, it takes all objects  
45. For the AS/400 application that takes data only thru the keyboard input and not even single mouse click  
46. How to write QTP test results to an Excel application  
47. How to write recovery scenario for below questions and what are the steps we will follow?if i click  
48. If winrunner and QTP both are functional testing tools from the same company.why a separate tool QTP  
49. How do we test Links using Quick Test Professional and confirm that the page we are requesting is seen  
50. How do you test DLL files using QTP?  
51. After importing external .xls datasheet in to Datatable of QTP, How to set NO of iterations run for  
52. How to test Dynamic web pages using QTP  
53. How to record Flex (1.0) objects using QTP?Post the code which works for this.  
54. Advantage of using Mercury Quality Center over Test Director  
55. How do we connect to Oracle database from QTP ?  
56. Can any one pls tell me about how to configure the environment variables in qtp and how to use the variables  
57. What is the process for creating an automated test script using QTP assuming you have reviewed the manual  
58. How to use a data driver in QTP?  
59. What is the method used to focus on particuler field.I need the script.I will give example.I flights  
60. 1)what is the advantage and disadvantage of using Virtual Object wizard?2) How efficiently we can use  
61. Without recording objects in Object Repository are we able to run scripts?  
62. Can we call a QTP script from a main script without making it reusable?  
63. wat is xml schema validation and how to perform schema validation for a file.wat is *.XSD extention 64. Can any 
body expalin me the differences between a reusable and a external action with example?  
65. I need information on using FSO(file system object) also its significance  
66. How to Run a script recorded in English flavor of my application and re-run the same script on different 67. How to 
write QTP test results to an Excel application, Please provide the exact code if possible ASAPThanks  
68. What are the limitations for XML Checkpoints in QTP 8.0?  
69. how good is QTP for testing siebel applications?whether QTP recognizes siebel objects or something else  
70. How do I use text checkpoint in QTP as everytime I use this checkpoint in the excel sheet and highlight  
71. How is automation used in QTP for regreession testing. Please give me a sample script.  
72. Anybody explain me, the concept of checkpoint declaration in the QTP mainly for the Objects, Pages, Text  
73. How can we validate the PDF file recognization and its content with the help of Mercury product QTP(Quick  
74. What is Expert view in QTP?Can you explain with example?  
75. What is the best way to do regression testing using QTP.  
76. what is the use functions in QTP. public, private  
77. How can we return values from userdefined function? anybody provide code with small example its great  
78. how to retrive/update database by writing code in expert viewIn my case database is Accessmy dsn 
name="try"database  
79. How can I import and/or merge an existing repository into my current test?  
81. Hi,I was set the repository as per test mode and recorded my script. Now I wana to change the repository  
82. What are Limitation of QTP?  
83. what is difference between stub and driver? 
84. What is meant by Source Control?  
85. What is descriptive programming?  
86. how to automate editing an XML file .because when i record the editing on an XML file and run it,some 
87. What are the disadvantages or drawbacks in QTP?  



 

 17 

88. 1. Each test that you run is displayed into the screen ... I'm looking for a way to run a test in background  
89. I have faced one question in interviewhe has given one screen with one bitmap and one edit box.The original  
90. What qt plus ? How we merge the files in qtp?What is feasibility study in automation? 
91. when a script is recorded in quick test for connecting 10 rows in the database, can we change script 
92. How do you test siebel application using qtp?  
93. How to get Traceability matrix from TD? 
94. How to import a test case present in ".xls" file to TD under a Test set? 
95. How to attach a file to TD? 
96. What do you to script when objects are removed from application? 
97. How do you data drive an external spreadsheet? 
98. Give me an example where you have used a COM interface in your QTP project? 
99. How long have you used the product? 
100. How to get "FontSize" of a "WebEdit"?101. Is there anyway to automatically update the Datasource name in 
Database Checkpoints object when we migrate tests to a new release? 

102. How to create a Runtime property for an object? 


